Q
5"‘
o
=5
P
%

‘a;

% 3
| II £ COMMUNITY
é‘" PLANNING

:9 \, &
AN DEVE DEVELOPMENT

Using eCart for the ESG CAPER
October 29, 2015

Presenters: Resource Advisors:
Marlisa Grogan Dan Fox
Michelle Budzek Joel Remigio

David Durkalski
Meradith Alspaugh




Webinar Format

e Webinar will last approximately an hour
e Recording will be posted on the HUD Exchange

* |f you have technical difficulty with the audio
or video portions of this webcast, try:

— Using your phone instead of the computer
— Logging off, then logging in again

— Requesting help from organizers through the
“Chat” pane of the “Go To Webinar” toolbar



Submitting Questions

 Due to the high volume of participants, everyone will be
muted during the presentation.

e Submit questions at any time during the webinar via the
“Questions” pane of Go-to-Webinar.

e |f your question is not answered during the presentation,
please submit it to the Ask A Question section on the
HUD Exchange — selecting ESG in Step 2.

Ask A Question
Step2of2 [N

* My question

: ESG: Emergency Solutions Grants
is related to:



https://www.hudexchange.info/get-assistance/my-question/

Objectives

Webinar participants will learn about:

Data flow from HMIS to the eCon Planning Suite
Uploading subrecipient CSV files into eCart
Correcting data validation errors

Using the eCart to filter ESG data

Embedding eCart into a Word document

Attaching eCart to the CAPER in the eCon
Planning Suite

Troubleshooting common eCart problems



Background

The ESG-specific CAPER screens are:

CR-60 Subrecipient Information: Manually complete
using internal records.

CR-65 Persons Assisted: Do not complete these
tables. Instead, attach the eCart file to CR-00.

CR-70 Assistance Provided and Outcomes: Manually
complete using internal records.

CR-75 Expenditures: Manually complete using
internal financial records.



Background (continued)

e New eCart requirement is applicable for PY 2015
CAPERs (earliest submissions starting in October
2015, which are due by December 31, 2015)

e Reporting on outcomes for the first time

e Reporting on data elements required by 2014
HMIS Data Standards

e Collecting national ESG Program data

e Achieving consistency with CoC Program annual
reports



IE S

eCart (ESG-CAPER Annual Reporting Tool):

An Excel spreadsheet that loads report level, aggregate
information from HMIS and captures all required data
on participants served in ESG-funded projects.

CSV (Comma Separated Value):

The export that recipients will use to populate eCart
for submission to HUD.



Terms (continued)

Projects:

The ESG-funded activities as set up in HMIS:
Emergency Shelter, Day Shelter, Transitional
Housing, Rapid Re-housing, or Homelessnhess

Prevention. Each project requires its own HMIS
report.

Components:

Eligible categories of ESG funding: ES, SO, RRH, HP,
HMIS. Several project types fall under the ES

component: Day Shelter, Transitional Housing, and
Emergency Shelter.



Report Flow from HMIS to eCart

Subrecipient (Homeless Provider)
provides the funded ESG

housing/service & records client level

data in HMIS.

Subrecipientruns the ESG CAPER )
report either directly from their HMIS
or by using the ESG CAPER Generation

Tool.
-

Subrecipient sends the “zipped file” of
the reportin CSV format to the
Recipient.

Recipient gathers a zipped file
from each ESG-funded project
and uploads them into eCart




eCart Introduction Tab

" Introduction [ilelela@pEIEM Check Your Data Report with Filters | Combined Report | Data

—
r. N

* Click buttons below to navigate the eCart Guide

Introduction and Revision History
Section 1: ESG Reporting
Section 2: Project Level Reporting Information

Section 3: Questions/Tables for ESG Reporting
Section 4: Create eCart .
Section 5: Check Your Data

Section 6: Review Your Reports
Section 7: Uploading eCart for Submission to HUD

Section 8: Functions and Information
TROUBLESHOOTING

Next Page Print this Page




eCart Import Data Tab

_Introduction |[MINIIIAREIEM Check Your Data Report with Filters | Combined Report | Data |

A

Submission Information Form - Enter information about the ESG recipient:

Required Answered

Reporting Jurisdiction: Name typed in this cell * |
*

Program Year Start Date:

X

Program Year End Date:

Click here to choose a folder and import data




eCa rt CheCk YOur Data = duplicate projects

Introduction [NNERSGCH Check Your Data | Report with Filters | Combined Report | Data |

3 Should
Should match this match
Error in Project in Question at Cell cell Plus this cell Value value Difference

Duplicate project
name APR - Services Only Data!5Q517

Duplicate project
ID APR - Services Only Data!SRS17




eCart Check Your Data - data errors

3 Should

Should match this match

Error in Project in Question at Cell cell Plus this cell Value  value Difference

Duplicate project

name APR - Services Only DatalsQ517

Duplicate project

ID APR - Services Only Datal5RS517
Q6a | c. Number of

Totals do not Q10b. Genderof  Q10b | h. Subtotal children {under

match Agency A- RRH Children Total age 18] 17 21 -19%

022c. RRH Length Qfa | a. Total

Total cannot be of Time between 022c | . Total | number of persons

greater than Agency A- RRH Project Entry Date Total served 36 35 3%
Q6a | k. Number of Q6a | I. Number of

Total cannot be Q7a. Number of Q7a | Total adult heads of child heads of

less than APR - Services Only Households Served households | Total household household 1 11 -92%
06a | a. Total

Totals do not Q10d. Genderby Ql0d | h.Total |  number of persons

match APR - Services Only Age Ranges Total served 11 16 -31%
Q6a | a. Total

Totals do not Q10d. Genderby Ql0d | h.Total |  number of persons

match APR - Services Only Age Ranges Total served 15 16 -6%
Q6a | a. Total

Valueisnota Qlod. Genderby  Qi0d | h. Total | number of persons

number APR - Services Only Age Ranges Total served 16y 16




eCart Check Your Data — 25%7?

If data the data on any project exceeds a 25% error rate
the subrecipient for that project should be asked to
review and correct their data and resubmit a CSV
report.

If the data cannot be corrected (e.g. subrecipient just
didn’t collect the information) then the recipient is to
explain the situation/reason for the error in the
narrative text box in screen CR65 along with what
corrective action plan they have for the future and
the field office will use that information in its CAPER
review.



eCart Compliance Issues

e HUD expects comparable databases to have the functionality to
extract ESG data using HMIS software or the ESG CAPER
Generation Tool so recipients can upload that data into eCart.

 When a subrecipient cannot meet this standard, the recipient
must contact its local HUD Field Office and Marlisa Grogan
(Marlisa.M.Grogan@hud.gov) from SNAPS to request an
exception to the eCart requirement for good cause. For
example:

A subrecipient is working to upgrade its comparable
database to perform the CSV export, but the upgrade will
not be completed in time for the CAPER submission.

 The subrecipient must have an acceptable plan and timeline for
coming into compliance.


mailto:Marlisa.M.Grogan@hud.gov

eCART Report with Filters

Introduction ' Check Your Data Report with Filters | Combined Report | Data

Q5. HMIS DQ & Participation Filters Change filters on Data tab
5a. HMIS or All organizations
Comparable Database
Data Quality Q5a Organization(s)
Client
Doesn't
Data not
Data Element Know or
: collected
Client
Refused
First name 0 0
Last name 0 0
Project
SSN 0 .
type(s) All project types
Project A A- Family Shelt
Date of Birth 0 ; SeneY. AR 2Reter
name(s)
Race 0 0
Ethnicity 0 0
Gender 0 0
eteran Status 0 0




eCART Report with Filters (continued)

" Introduction [NPERICEGE Check Your Data

Report with Filters | Combined Report | Data

Filter data shown below and on Report with Filters tab

Organization i

Project name

Agency A &)

Agency B

Agency C

Project Type 8
~

(blank) 8

]

Agency A - RRH
Agency A- Family Shelter

Agency B- Better ES

Agency C Safe Shelter




Overview of eCart Tabs

" Introduction || Import Data | Check Your Data | Report with Filters | Combined Report | Data |

« The Combined Report tab always shows a full,
unfiltered report containing all data loaded into eCart,
reflective of the total number of persons in all ESG-
funded projects for the program yeatr.

« The Combined Report is not a report of “unduplicated
clients”. For example:

A client may be served in two different shelters, a street
outreach project and RRH in the same year. Thus, that client
will be reported 4 times on the Combined Report tab.



Overview of eCart Tabs (continued)

" Introduction || Import Data | Check Your Data | Report with Filters | Combined Report | Data |

ﬂ

 The Data tab contains the data you imported in a
“flattened” (one project per row) format.

e Use this tab to:
o0 Remove duplicate projects using the wiper function;

0 Take a closer look at the source of data errors identified on the
Check Your Data tab:;

o0 Select filters for the Report with Filters tab.

« Data are locked and cannot be changed on the Data
tab. If the data errors exceed 25%, ask the subrecipient
to correct the errors in HMIS and send you a new CSV
file.




Embedding eCart in a Word File

1. Open up a new Microsoft Word document and save it in a
place where you can easily find it.

2. From the “Insert” menu screen, click “Object.”

Insert Page Layout Reference Nuance PDF

Table | Picture Clip Shapes Smartart Chart Screenshot | Hyperlink Baokma

i

3. Click the “Create from File” tab, then click “Browse” to
select the eCart file: = =

Object

[ Create Newj | | Create from F:Ie‘g

File pame:
s ==
| S—
[ uink to file
[] bisplay as icon
Result

.. Inserts the contents of the file into your

EE document so that you can edit it later using the
application which created the source file.




Embedding eCart in a Word File

(continued)

4. Check the box for “Display as icon” and click “OK”.

[ Object (2 o)

File name:
-APER TESTING\Copy of ECART Import Tool v 120151009.xsm| [_Browse... |

|E

Result .
Inserts an icon that represents the contents of gda I

@_@ the file into your document.
Copy of ECART
Import Tod v 1 2015:

5. Once you click “OK,” an icon of your eCart Excel file appears
directly in your Microsoft Word document.

iAo ok —




Attaching eCart in the eCon Planning Suite

Consolidated Annual Performance Evaluation Report

CR-00 - Administration

|Save | | [Save and Retumn| | [ Cancel]

Program Year:*
Title:
Version:™

Programs included:

AAP Plan Year:
AAP Title:
AAP Plan Version:

Attachments

[caPER
[1

CcDBG
HOME
ESG
HOPWA

AVELYRLARLY

2014
2014 State of Minnesota Action Plan
MN1

Attachment 1
Attachment 2
Attachment 3
Attachment 4
Attachment 5

Browse to Attach

Browse to Attach
Browse to Attach
Browse to Attach
Browse to Attach

Status:

Status changed on:

| Open in Progress v

Tue, Oct 13 2015 at 5:09:54 PM EDT

[Save| | [Save and Retum| | [Cancel|

1. Click “Browse to
Attach” on screen
CR-00 of the eCon
Planning Suite.



Attaching eCart in the eCon Planning Suite

(continued)

2. Enter a “Title” for
your eCart Word file.

Plans/Projects/Activities

I You have 22 CDBG activities that have been flagged. Click on the number to go to the review page.

CR-00 - Administratio s N
minisTration &) Add File saveMode= - Google Chrome oo o -
Save | | [Save and Retum) | @ https://cpd2.hud.gov/idis/cprAttachFile.do?submit=8&csld=410010 I - k 0 h . I ’”
Program Year:* [2014 M“t 3 ] C I C C Oose I I e

Title: feCat |

T | == to select the eCart

Programs included: v cpeg 1

“/ HOME Save| |J[Cancel -
Word file
+ HOPWA [ ]

AAP Plan Year: 2014

4. Click “Save”, which
will return you to the

Attachment 2
Attachment 3
CR-00 screen
Attachment 5 "
Status: [Openin Progress v|
Status changed on: Tue, Oct 13 2015 at 5:09:54 PM EDT

Save| | [Save and Retum| | [Cancel




Attaching eCart in the eCon Planning Suite

(continued)

Consolidated Annual Performance Evaluation Report

CR-00 - Administration

Save | || Save and Retum | | Cancel

Program Year:™ 2014

Title: [CAPER

Version:™ |1

Programs included: v cpBG
¥ HOME
Y ESG
Y HOPWA

AAP Plan Year: 2014
AAP Title: 2014 State of Minnesota Action Plan
AAP Plan Version: MN1

Browse to Attach
Browse to Attach
Browse to Attach
Browse to Attach

Browse to Attach

Attachments
Attachment 1
Attachment 2
Attachment 2
Attachment 4
Attachment 5
Status: Open in Progress v
Status changed on: Tue, Oct 13 2015 at 5:09:54 PM EDT

Save | | Saveand Retumn |  Cancel

5. Go to the top of the
screen and click “Save
and Return,” which will
take you back to the
CAPER menu screen.



Attaching eCart in the eCon Planning Suite

(continued)

6. From the CAPER

oo o menu screen, click on
screen CR-00 to

e confirm that the Word
file with the
embedded eCart was
AAAAAAAAAA ion: MN1 SUCCGSSfU”y
— e attached.

|Save | | |Save and Retumn | | | Cancel |




Resources

e eCart (includes eCart Guide)

https://www.hudexchange.info/resource/4785/ecart-esg-caper-annual-
reporting-tool-and-guide/

e Con Plan Desk Guide

https://www.hudexchange.info/resource/2641/econ-planning-suite-desk-guide-
idis-conplan-action-plan-caper-per/

e ESG CAPER Generation Tool

Ensure you are signed up for the ESG Listserv group on the HUD
Exchange to receive the announcement when HUD releases the
updated tool.



https://www.hudexchange.info/resource/4785/ecart-esg-caper-annual-reporting-tool-and-guide/
https://www.hudexchange.info/resource/2641/econ-planning-suite-desk-guide-idis-conplan-action-plan-caper-per/

Live eCart Demonstration

e Uploading subrecipient CSV files into eCart
e |dentifying data validation errors
e Using the eCart to filter ESG data

 Troubleshooting common eCart problems
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